


Select a 3D Gallery

1 To select a new gallery, click the left-mouse button on the Galleries Drop-down Arrow.
2 Drag down the list to highlight the desired gallery name.
3 Select the desired gallery by clicking the left-mouse button.
The selected gallery will be displayed in your Gallery View until you select another 3D gallery.

Windows 



Select a 3D Gallery Object

1 Select any 3D gallery in the Gallery Window.
2 Point to an object in the selected 3D gallery.
3 Click and hold the button to select it.
4 Drag it to the Design Window and release the mouse button.

Tip:
At the bottom of the Gallery Window in the Preview Area, you see a 3D representation of the 
highlighted object. Click the Rotate buttons at the bottom of the Preview Area to rotate the 
highlighted object in 3D.

Gallery Window 

Windows 



Use a Basic 3D Gallery Object

1 Point to an object in the Basic shapes 3D Gallery and click to select it. 
You see a 3D representation of the highlighted object. 

2 Click on the Rotate buttons at the bottom of the Preview Area to rotate the highlighted object in 3D.
3 To move the selected gallery object to the Design Window, drag it from the Gallery View to the 

Design Window.
4 Position the object, and then release the mouse button.

A two-dimensional object outline appears in the Design Window where you released the mouse 
button, and a 3D object appears in the Walk Window.

Gallery Window 



Move an Object

1 With the Select Object Tool, choose the object.
2 Move the object by clicking on it and holding the mouse button down while dragging.

Note:    Clicking on and/or dragging an object’s sides or handles might result in modifications to the 
object. To move an object, make sure you click on the body of the object, not a handle or a side.

Design Window Tools Pad 



Select an Object

Before you can edit an object, you must select it. A selected object changes color and shows small 
squares at its corners. You can select an object in the Design Window or in the Walk Window.

IN THE DESIGN WINDOW
1 Click the Select Object Tool in the Tools Pad.
2 Point to the object that you want to select.
3 Click.

IN THE WALK WINDOW
1 Click the Select Object Button in the bottom of the Walk Window.
2 Point to the object in the Walk Window that you want to select.
3 Click.
4 The selected object appears in the center of the Design Window and is selected.

Design Window Tools Pad 



Group Objects

1 Select multiple objects with the Select Object Tool by holding the shift key and selecting multiple 
objects.

2 Under the Design menu, select Group.

Design Menu 



Lock an Object

1 Select Lock Object Tool.
2 Click the object that you want to lock.
3 The object cannot be selected or edited in any way until it is unlocked with the Unlock All option from 

the Edit menu or with the unlock tool.

Design Window Tools Pad 
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Unlock an Object

1 Select the Lock Object Tool.
2 While holding the Ctrl key down, click the object you want to unlock.

Tip:
Hold the Ctrl key down while using the lock tool on a locked object and the object is unlocked.

Design Window Tools Pad 
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Add a Handle to an Object

1 Select Add/Remove Handle Tool which is one of the tools in the Tools Pad.
2 Point to the segment of the outline in the Design Window where you want to add the new handle.
3 Click on the segment.

Depending on the speed of your machine, there may be a brief pause before the handle appears.
4 If a handle does not appear, select Add/Remove Handle Tool, point to the location on the outline 

where you want the new handle, click, and drag the surface slightly outward.
Note:    You cannot create non-convex shapes with this tool. You will always be adding a handle outside 
the bounds of the two handles you are in between.

Design Window Tools Pad



Remove an Existing Handle

1 Select Add/Remove Handle Tool.
2 Point to the handle.
3 Click.
Depending on the complexity of the object or surface feature and the speed of your machine, there 
may be a brief pause before the handle disappears.

Tip:
n If your goal is to create an irregular object or surface feature, you might want to try the Create 

Irregular Object Tool instead of the Add/Remove Handle Tool. Both tools can accomplish the same 
result, but you may prefer one method over the other.

n You can reposition a new handle when you add it by dragging instead of clicking.

Design Window Tools Pad 



Resize an Object

1 To resize an object, point to an object handle with the Select Object Tool.
2 Drag the handle.

Tip:
n If an object is grouped, the Select Object Tool cannot be used to reshape the grouped object. The 

grouped object must be ungrouped (with the Ungroup command under the Design menu) before the 
Select Object Tool can reshape the pieces.

n Depending on what dimensions you are viewing in the Design Window (Top, Front, or Right), the 
reshaping capability of the Select Object Tool may be limited. Object handles indicate to what extent 
an object can be reshaped.

n When you drag a handle, an object maintains its type. For example, if you drag the handle of a 
rectangular object, the object remains rectangular. If you drag a handle of an octagon, the object 
remains an octagon. This is true for regular-shaped objects; however, handles of irregular-shaped 
objects move individually.

n If you hold down the Ctrl key while dragging a handle of a regular-shaped object, the object becomes 
irregular.

n You can also drag a line between two handles for certain handle types, depending on the type of 
handles.

Design Window Tools Pad 
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Resize an Object About Its Center

1 Select the object to be resized.
2 Select Resize Object Tool.
3 Point to a reference point (such as a corner).

Drag the object to its new size.

Design Window Tools Pad 
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Resize an Object About a Specified Anchor Point

1 Select the object to be scaled.
2 Select Resize Object Tool.
3 Point to the desired location at the anchor point.
4 Hold down the Ctrl key and click to establish the new anchor point.
5 Point to a reference point and drag to a size.

Tip:
n You can resize objects independently along the three coordinate axes (dimensions).
n When an object is resized, its contents and any surface features are resized proportionally. If this is 

not what you want, use the Select Object Tool to reshape the object.
n To resize an object uniformly along all three dimensions (X, Y, Z), hold down the Shift key before 

dragging.
n If you add a surface feature to an object and then resize the object, the surface feature is 

automatically resized to match the new scale of the object.

Design Window Tools Pad 
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Skew an Object

1 Select the object you want to skew.
2 Select Skew Object Tool. 
3 Point inside the object outline.
4 Click.
5 Drag in the direction(s) you want to skew.

Tip:
You can use the Skew Object Tool to skew on more than one axis but only from the view in which the 
object was created.

Design Window Tools Pad 



Rotate an Object

1 Select the object that you want to rotate.
2 Select Rotate Object Tool.
3 Point to any location in the Design Window to establish the center of rotation.
4 Click.
5 Drag the pointer away from the center of rotation.

A dotted line appears between the pointer and the center of rotation.

Tip:
n As you drag the pointer farther from the center of rotation, you gain finer control over the angle of 

rotation. Drag the pointer in an arc around the center point to rotate the object.
n Contained objects are rotated with the container unless you hold down the Ctrl key when you rotate 

an object. Holding the Ctrl key rotates the container but not the contained objects.

Design Window Tools Pad 
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Connect Two Objects

1 Select an object with the Select Object Tool and align the object next to the object you need to 
connect it to.

2 Select the Connect Surfaces Tool from the Tools Pad.
3 Where the two object meet, click the Connect Surfaces Tool.

The two objects are now connected.

Tip:
• Another technique is to select the side you want to connect with the Connect Surfaces Tool. With the 

tool, drag the side to the wall you want to connect to.
• You can verify that the two objects are connected by using the Observer (round circle). Place the 

Observer inside one of the objects and move it through the opening between the two objects. As the 
Observer approaches the opening, you should be able to see into the adjacent object if the 
connection is made properly.

Design Window Tools Pad



Cut a Hole in an Object Surface

1 Select the Surface Editor Tool.
On the object in the Design Window, click on the surface you want to edit.

2 The Surface Editor appears and the Basic 2-D Gallery replaces the existing 3D gallery in the Gallery 
Window.

3 Select a two-dimensional object from the Basic 2-D Gallery and drag it onto the surface, or select the 
Create Rectangular Object Tool and draw it.
To close the Surface Editor, select the Return Button on the Tools Pad.

Design Window Tools Pad 
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Select an Object Surface in the Design Window

1 Select Surface Editor Tool.
2 Click on the surface that you want to select.

Design Window Tools Pad 
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Select an Object Surface in the Walk Window

1 Choose the 3D Select Surface Button.
2 Point to the 3D Surface in the Walk Window.
3 Click.

The selected surface is displayed in the Design Window and is aligned planar to your view.

Tip:
When the surface is displayed, you will notice that the title bar of the window has changed and the 
Tools Pads has also changed. This set of tools and windows is called the Surface Editor.

Walk Mode Navigation Buttons 



View a Selected Object in the Walk Window

1 Select the galleries drop-down arrow at the upper-right corner of the Gallery Window. A list of 3-D 
galleries will appear.

2 Select Rooms-Castle 3-D Gallery.
3 Select Slope 100 object and drag to the Design Window.
4 The Slope 100 object you dropped into the Design Window is now visible in the Walk Window by 

using the Navigation buttons.

Navigate 
Select a 3D Gallery 
Navigation Buttons 



Modify the Opacity of a Surface

1 Select the surface.
2 Choose an opacity type in Tools Pad (Make Opaque or Make Transparent).
3 Click on the object.

Tip:
You can also modify an object’s opacity by selecting the object and double-clicking the Opacity 
Modifier in the Tools Pad.

Surface Editor Tools Pad 



Select Texture Galleries

1 Click on the Textures tab.
2 Click on the Preview Area drop-down to display a pop-up menu for adding textures. Select Add 

Textures.
3 A Select textures drop-down list provides a gallery of textures (the textures in the Virtus .wad file).
4 Select the texture you want to add.
5 Click OK.
Warning:    There is a limit on the number of textures you can load at once. The limit depends on the 
amount of RAM and free swap space you have available.

Tip:
To select more than one texture:
n Hold down the Shift or the Ctrl key.
n Select the other textures you want. 
n Click OK. 

The textures are added to your Texture View.

Windows 



Add Textures to Objects

There are three methods to add textures to objects:

METHOD ONE
1 Select a texture from the Texture Window.
2 You see a close-up view of the highlighted texture in the Preview Area.
3 Drag the texture from the Textures Window onto a two-dimensional surface in the Design Window.

The texture appears on the 3D object in the Walk Window.

Tip:
You can also drop textures onto a 3D object’s surfaces in the Walk Window.

METHOD TWO
1 Select the texture.
2 Select Auto Texture Tool in the Walk Window.
3 In the Walk Window, click on the surface where you want to place the texture.

METHOD THREE
1 Select an object.
2 Double-click on the texture you want to use on the selected object.

Windows 
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Create Your Own Custom Objects

1 Model the object in the Design Window.

2 Right-click on the object after the customization.
3 In the Hexen 2 Object Properties dialog, select Object Tab.
4 Select Custom from the Class drop-down menu and fill in the name of the object in the Name text 

box.

Tip:
To save the new custom object, you can drag it into the gallery.

Hexen II Object Properties Dialog 



Scaling Objects
See Resizing objects.

Resize an Object 



Dragging & Dropping Textures

There are three methods to add textures to objects:

METHOD ONE
1. Select a texture from the Texture Window.
2. You see a close-up view of the highlighted texture in the Preview Area.
3. Drag the texture from the Textures Window onto a two-dimensional surface in the Design Window.
4. The texture appears on the 3D object in the Walk Window.

Tip:
You can also drop textures onto a 3D object in the Walk Window.

METHOD TWO
1. Select the texture.
2. Select Auto Texture Tool in the Walk Window.
3. In the Walk Window, click on the surface where you want to place the texture.

METHOD THREE
1. Select an object.
2. Double-click on the texture you want to use on the selected object.

Add Textures to Objects 



Create and Open Maps

1 To create a new map, choose New (Ctrl+N) under the File menu.
2 Hexmaker will be displayed on the monitor with a blank Design Window (except for the Observer) 

and Walk Windows. A new map can now be created by the user.
3 To open an existing map, choose Open (Ctrl+O) under the File menu.
4 Use the Open dialog to select the Hexmaker map that you wish to edit by double clicking on that 

map.

File Menu 



Activate a Window

Activating a window means that you can select objects and press buttons for that window. You make a 
window active by clicking anywhere in or on it. An active window displays a highlighted title bar. If a 
window is not active, its buttons and tools are shaded and are not able to be selected. If the Design 
Window is not active, the Design Window Tools Pad is not visible.

Windows 
Design Window Tools Pad 



Navigate

You can walk around in your Hexmaker level using one of two methods:

METHOD ONE: BUTTON NAVIGATION
The navigation buttons are always active when the Walk Window is active. Click on one of the 
navigation buttons to move in that direction.

Tip:
If you hold down the mouse button while pointing to a navigation button, you move continuously.

METHOD TWO: CURSOR NAVIGATION
Besides the navigation buttons, you can also use the cursor to navigate in the Walk Window. You can 
choose normal mode navigation or advanced mode navigation. Movement of the mouse pointer is 
relative to the cross hair in the center of the Walk Window.

Normal Mode Navigation
For normal mode navigation, position the pointer above the cross hair. This enables forward 
movement, below enables backward movement, etc. The left mouse button is pressed to begin 
movement and released to stop it. The further the cursor is positioned away from the cross hair, the 
faster the walk speed. Direction is determined by the position of the pointer relative to the cross hair 
(above, below, left, right, etc.).

Advanced Mode Navigation
For advanced mode navigation, use a combination of the Shift key or the Ctrl key and the mouse. 
Movements like tilting your head, sliding from side to side, or increasing and decreasing your altitude 
are also possible. These keyboard combinations for navigation modes are illustrated at the right.
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Move the Observer

1 Click the Select Object Tool in the Tools Pad.
2 Point to the center of the Observer.
3 Click on and drag the Observer to the lower left corner of the Top View. The Observer follows the 

cursor as you move the mouse, allowing you to reposition the Observer manually.

Navigate 
Navigation Buttons 



Change Observer Line of Sight

1 Point to the center of the Observer.
2 Hold down the Ctrl key.
3 Click and drag to the right of the Observer.
4 Release the mouse button and the Ctrl key.

The black line in the middle of the Observer represents which way you are looking — your line of 
sight in the level.

Move the Observer 
Navigation Buttons 



Cut, Copy, Paste

1. To cut or copy an object from the Design View, first select the object to be cut or copied.
2. From the Edit menu, select Cut (Ctrl-X) to cut the object or select Copy (Ctrl-C) to copy the object.
3. The object is now stored on the clipboard.
4. To paste the object, select the point in the Design View where you want to place the object.
5. From the Edit menu, select Paste (Ctrl-V).

The object may be pasted multiple times.

Edit Menu 



Add a New Layer

1 Under the Design menu, choose New Layer.
2 The Layer Name dialog will appear.
3 Enter the name of the new layer and then click OK.

Notice that the new layer name is now displayed in the Layer List.

Design Menu



Coloring Layers
1 Under the Window menu, select Layers.
2 Right-click on the layer that you want to color in the layer list.
3 Select Change Color in the drop-down menu.
4 The color palette will be displayed.
5 Select the desired color for your layer and then click OK.
6 The layer will now be that color.

Window Menu 



Hiding Layers
1 Under the Window menu, select Layers
2 Right-click on the layer that you want to hide in the layer list.
3 Select Hide in the drop-down menu.
4 The layer will now be invisible.

Repeat steps 2 and 3 to make the layer visible again.

Window Menu 



Locking Layers
1 Under the Window menu, select Layers
2 Right-click on the layer that you want to lock in the layer list.
3 Select Lock in the drop-down menu.
4 The layer will now be locked. It can no longer be selected or edited in any way until it is unlocked.

Repeat steps 2 and 3 to render the object again.

Window Menu 



Rendering Layers
1 Under the Window menu, select Layers.
2 Right-click on the layer that you want to stop rendering.
3 Select Render from the drop-down menu.

The layer will no longer be visible in the Walk Window.
This technique is used to speed up rendering and navigation.

4 Repeat steps 2 and 3 to render the layer again.

Window Menu 



Move an Object to a New Layer

1 Select the objects you want to layer.
2 Double-click the name of the layer you want to add the object to in the Layer List. A dialog will be 

displayed for you to verify the move.
3 Click OK.

Add a New Layer 



Hiding Layers in the Design View

1. In the Window menu, make sure the Layers window is checked.
2. In the Layers window, right click on the layer to be hidden.
3. Click on Hide with the left mouse button.

Window Menu 



Tumbling Objects

1. Select the tumble editor tool from the design view tools window.
2. Click on the object you wish to tumble in the design view.
3. Select the Move View tool from the tumble editor tool pad.
4. Drag the mouse to rotate the object in 3D space.

Design Window Tools Pad 



Slicing Objects

1. Select the Tumble Editor Tool from the Design View tools pad.
2. Click on the object you wish to slice in the Design View.
3. Select the Slice Tool from the Tumble Editor Tool pad.
4. Click and hold the left mouse button on a point outside of the object.
5. Drag the mouse through the object.
6. Release the mouse button.



Deleting Slices
To delete a slice from the Slice List, choose the slice and press the Delete key.



Reversing Slices
To remove the other side of the slice you just made, select Reverse Slice from the Slice List.



Add Objects to a Gallery

You can add to a gallery by dragging objects you created from the Design Window into the gallery.
1 Open the gallery in which you want to place the object.
2 Create an object or set of objects in the Design Window.
3 Drag the objects into the gallery.
4 Enter its name in the Save Object As dialog.
5 Click OK.

Select a 3D Gallery 
Select a 3D Gallery Object 
Use a Basic 3D Gallery Object 



World Properties

1. Under the File menu, select Game Options.
2. The Game Options dialog will appear.

The Game Options dialog contains various options that can be changed to make creating your 
levels easier and enhancing the customization.

The Hexen II Load Options has two items: Class and Skill. Class has four types of characters that 
the Hexen II player can be — ranging from a Paladin to an Assassin. The Skill category has 
selections for four skill levels for a player depending upon which class of character was selected. If 
you choose to load Hexen II using the Hexen Export command, the Class and Skill Level 
selections that you have made here will be part of the exported information.

The Level Options set how the level appears and sounds when you run it in Hexen II. The level title 
is the title that appears on the screen when it is loaded. The World Type determines what era of 
civilization the player, characters, and objects are from in the level. The MIDI and CD Track tell 
Hexen II what music to play if the user chooses to listen to music while playing.

The Game Options are here to allow you to customize the actual Hexen II pieces that are used. 
The Wad Name file name is the default file that is used when you load textures into Hexmaker. We 
allow only one texture file per level. If you change the file in the middle, some textures may not 
show up when you export to Hexen II. There are utilities out on the net to add textures into a .wad 
file. This means that all of the textures you want can be in the same file.

Game Name is the actual program file that executes when you launch Hexen II from Hexmaker. 
You may want to change this to play the GL version of Hexen II or a new version that is released 
later.

The Strings.txt file is the file where all of the strings used as messages are written so that Hexen II 
can use them. Be very careful with this file as it is an integral part of Hexen II. We append 
message strings to the end of this file if you enter a new message that Hexen II does not yet have 
available to it. We also write out a .txt file with the same name as your .map file that has all of the 
strings in it as well as the indexes into the strings.txt file. This is for later use by you as a means of 
passing your levels around on the net. Please make sure you understand the workings of the 
strings.txt file before you change it. It can affect how the Hexen II levels that came with the 
program play.
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View the Hexen II Object Properties Dialog

Right-click on the object in the Design Window.
The Object tab in the Hexen 2 Object Properties dialog is used to set a specific item’s properties. The 
Attributes tab allows you to set the properties of an object so that it behaves the way you want it to in 
Hexen II.

The properties fall into several general groups:
Class:    This is a list of the Hexen II objects that you can use to create your level.
Attributes: In this area, the modifiable attributes for the class you have chosen will be listed.
Flags:    These are settings that can be turned on or off to affect the behavior of an item.
Levels:    These checked boxes determine the skill level where this item is available in Hexen II.

The Advanced tab has settings that affect Geometry and Custom items.
Geometry:    Object can be solid or hollow.

Contains: A list of items certain class objects can hold. These items show up when the object 
is killed or destroyed.
Custom Object has Geometry:    Allows custom objects to get exported with their 

geometry.

Select an Object 



Save Your File

1 From the File menu, select Save (Ctrl+S) or Save As ... .
If Save As was selected, the Save As... dialog appears.

2 In the File name box which is highlighted, enter a name for the file.
3 Click on Save.

File Menu 



Exporting Your Level

1. Select Hexen Export from the File menu.
2. The Export Hexen II Map File dialog is displayed.
3. The file name to be exported is shown in the File name box.
4. Select OK to export the file to Hexen II.map format.
5. After the .map format is written, the compilers will be run.

File Menu 



Exporter

The Hexen compiler interface will initially be displayed with the Bsp compiler, Remove temporary files and 
Launch Hexen II options checked.

The 3 check boxes [Bsp, Light, & Visibility] located at the top of the interface represent the 3 compilers 
needed to build a Hexen II level.      If one or more of these boxes is checked, the compiler associated with 
that check box will be executed when the "Start Compiling" button is pressed.

After the "Start Compiling" button is pressed, the text of that button is changed to "Stop Compilers".    If 
this button is pressed, it will terminate the current compilation.

A progress meter showing the elapsed time is displayed at the bottom of the window while the 
compilers are running.      If the elapsed time is not being updated, the compilers have crashed.    Press 
the "Stop Compiling" button, if the compilers have not terminated themselves.

The "Set Defaults" button sets all of the compiler options to their default values.    When the interface is 
closed, the current compiler settings are saved so that the next time the interface is launched, the 
same settings are displayed.

If the "Launch Hexen II" box is checked, then when the "Launch Hexen II" button is pressed, the 
interface will be closed and Hexen II will be launched.    If this box is not checked, the button will read 
"Close."    The interface will be closed when this button is pressed, and the user will be returned to 
Hexmaker.

If the "Create Batch File" option is checked, then the text of the "Start Compiling" button will change to 
"Make Batch File."    When this button is pressed, a batch file named "comph2.bat" will be created in 
the same directory as the hexmaker executable.    All of the compiler options that are selected will 
appear in this batch file.    The intent of this batch file is to give the user the option to run the compilers 
from a DOS box after terminating the Hexmaker program.    The compilers require A LOT of memory.      



You will need to have at least 150 Megs of free space on the drive that contains your swap file.    You 
may need to use this option if you do not have enough memory to run the compilers and Hexmaker at 
the same time.    The DOS compilers need to be in the same directory as the Hexmaker executable.    A 
stand alone version of the compilers with a Windows interface [Hexvici.exe] has also been included for 
your convenience.

"Remove temporary files" causes temporary files [*.pts, *.h?] to be deleted after the compilers are 
finished.

The "Clear" button clears the output window.

Check boxes – 

Bsp - run the BSP compiler when the "Start Compiling" button is pressed.
Light - run the Light compiler when the "Start Compiling" button is pressed.
Visibility - run the Visibility compiler when the "Start Compiling" button is pressed.

Create Batch File - create a batch file containing the currently selected compiler options when 
the "Make Batch File" button is pressed.

Remove temporary files - Remove the *.pts, *.h? files after compiling the level.
Launch Hexen II- Launch Hexen II with the level that was just compiled after closing the 
interface.

Buttons – 

"Start Compiling" / "Stop Compiling" / "Make Batch File" - "Start the compilers." / "Terminate the 
current compile" / "Create a batch file containing the currently selected compiler options."

"Set Defaults" - Set the options back to their default values.
"Launch Hexen II" / "Close" - Launch Hexen II with the map file that was just compiled. / Close the 

compiler interface.
"Clear" - Clear all messages in the output window.

The 3 option tabs display the options available for each compiler.    These options are explained in the 
following table.

COMPILER TABLE

      
Compile
r

        Option

        Name

      Default

        Value

          GUI                                               What It Does

      
QBSP

No Tjunctions FALSE Check box When this option is checked,    Qbsp will skip the 
compiler pass that finds & splits faces that have too 
many edges.    This option will decrease compile 
time.    This option should not be used for a final 
compile.

No Filling FALSE Check box When this option is checked, Qbsp skips the 
compiler pass that determines whether a leaf is 
occupied.    No leak file or port file is created. The 
bsp file will be larger than it would be if "nofill" were 
false.    This option should not be used for a final 
compile.

No Clipping FALSE Check box When this option is checked, the hull files are not 
created.    A bsp file cannot be created using this 
option unless the hull files already exist and the use 
hulls option is also true.



Only Entities FALSE Check box Only update the portion of the bsp containing 
monster information.    This option can be used if 
entities have been changed, but geometries haven't.

Verbose FALSE Check box Compiler will display more messages.

Use Existing 
Hull Files

FALSE Check box Use the existing hull files.    Do not create new ones. 
If this option is true and there are no hull files, the 
compile will fail.

Hull Number 0 Spin Control If    hull number = 1, create only the *.h1 file.    If hull 
number =    2 create only the *.h2 file, etc.    If there 
was a bsp file, it will be deleted.    When hull number 
=    0, h1, h2, h3, h4, & h5 will be created provided 
that usehulls is not true

Water Vis FALSE Check Box This has something to do with view points visible in 
water.

      
LIGHT

Extra 
Sampling

FALSE Check box Enable more sampling.    Makes lighting smoother 
with fewer "jaggies".    Compiler time will be longer.

Near/Far Slider Distance that light shines from its point source.

Dim/Bright Slider Brightness of the light.

          VIS

Fast FALSE Check box Allows faster vising by approximating what areas 
might be seen from a certain point instead 
calculating exactly what can be seen at a certain 
point.    Level will run slower and may have "grey" 
areas.

Test Level 2 Spin Control The number of times the bsp file is sent through the 
clipping algorithm. The level will play faster with a 
high test level.    The higher the test level, the longer 
it takes to run vis.

Verbose FALSE Check box More messages printed on screen

Gil Mode TRUE Check box Raven optimizations.

Loading Levels in Hexen II

Once the .bsp file has been exported, you need to load the level. You can load .bsp files one of two 
ways:

MANUAL METHOD
1 Copy the .bsp file to the Hexen II/id1/maps directory.

If that directory does not exist, create it.
2 Once the .bsp file is located in the maps directory, run Hexen II.
3 Display the Hexen II console by pressing the ~ (tilde) key on your keyboard, and at the prompt enter 

map <filename>.
For example, if your level was named mylevel.bsp, at the prompt enter map mylevel. The file name 
should NOT include the file extension .bsp.

AUTOMATIC METHOD
In the Export Hexen Map File dialog, after you have finished compiling the file, select Launch Hexen. 
You will now be able to see your new level in Hexen II.



Lay Out a Level with Paper and Pencil

1 Get some graph paper, a pencil, and a big, sturdy eraser and build a general outline for your level. 
Make a simple initial layout by creating the larger spaces with very little detail.

2 Next, fill in the spaces with rooms and connecting hallways.
3 Once you have sketched your large spaces, determine where players will go and how they will move.

Tip:
n In a single-player level, create a path that players must follow to get to the end of the level (or two or 

three, if you’re up for a challenge). Design your deathmatch levels with several paths, or perhaps 
several areas with paths going from one area to another.

n Don’t forget to take advantage of Hexmaker’s capability to create three-dimensional multilevel paths. 
Gaming in three dimensions is about up and down as well as forward and backward. For instance, 
you can design a path to leave a room on a lower level and re-enter it higher up. For players, part of 
the fun of a level is trying to figure out how to get up to that ledge or walkway they can see above but 
can’t reach! So, don’t make your levels flat.



Add Details to the Pencil and Paper Layout

After designing your horizontal and vertical spaces, rooms, and hallways, think about the appearance 
of each room and hallway (keep in mind your concept and theme). Then decide on which obstacles 
and benefits each should contain. If players enter the room more than once, how should it change from 
one player entry to the next? Include ambience items (crates, furniture, jutting ledges, monsters, 
weapons, health, etc.) in your levels only if they add ambience to your level. If you plan to add secrets 
to your level, now is the time to consider where they should be placed.

Tip:
n If you are designing a level for an episode, ask yourself these questions:
n What weapons do players already have?
n What weapons/benefits should they have access to?
n What monsters belong on this level?
n How hard is the level going to be?
n Where in the player’s path is the room?
n What obstacles does this room contain?
n What items does this room contain?
n What secrets does this room contain?
n What scenery does this room contain?
n What textures should I use there?
n What kind of lighting should I use?



Build a Level

We suggest building rooms along the path one by one. This lets you compile the level and tweak the 
look and feel of each room as you build it.

Tip:
Whatever you do, do not try to build it all at once: Build incrementally and save each version of your 
level under a different name. Your layout may have some unforeseen problems, or you may not like the 
way your plan works out in some places. Allow yourself time to check your progress and change your 
mind.



Geometry

A geometry is a three-dimensional shape used to create walls, define doors, and act as a placeholder 
for predefined objects. As a Hexen II level designer, you can create very complex or very simple levels. 
But remember that the complexity of an object and number of objects you place in a level affect the 
speed and performance when you work in Hexmaker and when players try to use your game or level in 
Hexen II. Why? It simply takes a computer longer to draw more objects on a computer screen.



Objects

Objects in Hexmaker are items such as weapons, mana, and health; architectural details such as 
arches and doors; and lights and torches—all found in Hexmaker’s 3-D galleries. Simply drag and drop 
objects from a gallery to design areas within the editor. Hexmaker objects define the position, 
attributes, and behaviors for corresponding Hexen II objects. For instance, when you drag a 
breastplate into a room you created in the Hexmaker Design Window, you are dragging a geometry 
placeholder into Hexmaker that looks like a breastplate, but it will only function as a breastplate after 
you export it into Hexen II. 

How do you ensure that your object behaves the way you want it to in Hexen II? Each object has 
properties. Right-click on an object in a Hexmaker Design Window to display the Hexen II Object 
Properties dialog. The properties and behaviors you assign in this dialog are exported into Hexen II 
along with the object.

Select a 3D Gallery Object 
Use a Basic 3D Gallery Object 
Create Your Own Custom Objects 
Add Objects to a Gallery 
Hexen II Object Properties Dialog 
Object Tab 
Attributes Tab 
Interaction Tab 
Advanced Tab 



Lights

Lights illuminate a sphere around their positions. Brightness determines how much light is emitted and 
how large that light’s sphere is. Although some lights appear in Hexen II as objects (torches, flames, 
and globes), the source of light is usually invisible. You might want to create a feature on the wall or 
ceiling to represent a light source.



Badguys

Badguys all begin facing a default direction, but this direction can be changed by setting the angle the 
bad guy faces. Since players sneak up on Badguys, you may want to position your Badguys at an 
angle that makes sense for the room it inhabits. You can also set Badguys to not respond to players 
unless the player shoots them.

Tip:
n If doors, Badguys, or buttons don’t seem to operate in the way you intended, you might have the 

wrong properties set in the Hexen II Properties dialog. For example, if a door doesn’t open wide 
enough to allow players to enter a room, the Hexen II Object Properties dialog must be set to 0 
degrees. Refer to the figure for the proper placement of objects and their value in the Angle setting.

n Here’s how you place figures:
1 Make certain that you are in Top View so you can look down.
2 Right-click on the bad guy.
3 When the Hexen II Object Properties dialog appears, click Attributes tab, and set the Angle    value.
4 Repeat for any other Badguys.



Mana and Health

As you design a level, give players enough armor, mana, and health to pass safely through the level. 
Scatter it around, but don’t make too much available—make the players work for it a bit. Placement is 
important, too; huge clumps of mana look unnatural. Small groups of different kinds of mana and 
health are convenient and welcomed after slogging through a series of multiple hard-to-kill monsters or 
shooting players in multiplayer games.

Tip:
If this is an episode level, make sure that the type of mana and health match the weapons and difficulty 
of the level.



Lifts

Lifts, also called elevators or platforms, begin at the bottom and rise to the top. They look more realistic 
if they have structural support to hold their weight and to enable them to rise (for example, a rail to 
attach it to, or    a hydraulic underneath it).



Doors

By default, doors open when players approach them. If you give a door a name, the door will not open 
until it is triggered. If you place multiple doors close together, they attempt to behave as one door. If 
you want to make a door out of more than one piece (for example, a two-piece door in which each 
piece moves away from the center, you have to make two doors that move in opposite directions.

You specify an angle for doors that controls the direction in which they open. Doors move as far in the 
direction you specify as their length in that direction. The Lip attribute determines how much less than 
its full length a door will move. If you give a door health, the player must shoot the door and do damage 
greater than its health to open it. You can also control the number of seconds that the door is open 
before closing.



Trigger

A trigger causes another event to occur in Hexen II when the trigger is activated or touched. For 
instance, pressing a button might cause a door to open or a lift to move. Setting up a trigger requires 
that you first name the object that you want to have triggered, like a door. Then, you must assign that 
door’s name to the Target attribute of the trigger, like a button. For example, if you create a door, you 
put a name like door1 in its Object Name text box. Then, when you create the button that causes the 
door to open, enter door1 in its Target text box. When the player touches the button, the door opens.



Skill Levels

When you create objects, you can set the Hexen II skill levels in which the object appears. You select 
beginner, intermediate, advanced, expert, or deathmatch level (or any combination) for the object to 
cause it to appear only in the specified skill level. That is, if you set a skill level of expert for a particular 
object, and a player is playing at an intermediate level, that object will not appear to that player.



Complex Geometry

Some objects, such as doors, have settings that define their behavior as well as geometry that defines 
their shape. Creating a complex geometry and making it act like a door requires a series of steps: You 
must create the complex geometry, group it, and set its class to Door in the Hexen II Object Properties 
dialog.



Object Types

Objects in Hexmaker are symbols. When you export your level, the Hexmaker export engine reads the 
symbols and places the appropriate objects into the Hexen II level during export. If a Hexmaker object 
is set to the class Geometry, it creates the correct geometry in Hexen II according to the size and 
shape of the object you created in Hexmaker. If a Hexmaker object is set to class blue mana, it creates 
blue mana in the same location in Hexen II.

We have provided objects in Hexmaker that look like Hexen II objects. Using these objects during your 
level building gives you a good idea of what the level will look like in Hexen II. These Hexen II objects 
are provided by Hexmaker and can be dragged and dropped into your level. Or you could use simple 
rectangles instead of Hexmaker’s textured objects and set their class labels to export different Hexen II 
objects. This could be useful if you want to speed up screen redraws while you’re designing your level.



Custom Objects

Advanced users can import custom objects into Hexmaker. You must first write the Hexen II C code 
and create the appropriate structure for the object to behave inside Hexen II. Then you have to know 
how to apply that object as a patch to Hexen II. You can then create a graphic for the object in 
Hexmaker and point to the Hexen II add-on or mod that you created.
Create Your Own Custom Objects 



Textures

Textures set a scene and establish the ambience of your level design. Hexen II requires a texture to be 
applied to every geometry. Some of the textures supplied with Hexmaker include crenellated metal, 
rough-hewn wood, dead and weedy grass, sullen gray skies, nasty slime, and hot, fiery lava.

Three types of textures exist: Normal, animated, and liquid. Normal textures set the look and feel of a 
room, tunnel, waterway, concourse, canal, corridor, outdoor area, etc. Some normal textures include 
metal, wood, tapestry, tile, carpet, grass, asphalt, concrete, dirt, stone, plastic, gravel, etc. Animated 
textures create special visual effects and include blinking lights, buttons changing colors when 
activated by touch or shooting, undulating sky, etc. Liquid textures, when applied to an object, give that 
geometry the properties of a liquid. When players see a liquid texture, such as water, it exhibits the 
appearance of water and behaves like water. Once players enter that texture, they are affected by it.

Tip:
n Liquid textures have some quirks. Generally, if a liquid texture is applied to a geometry, the entire 

object remains solid. In other words, if water texture is applied to the top of a rectangle, the geometry 
is just a rectangle with a thin film of water on top. But, if the liquid texture is applied to the rest of the 
rectangle, all of the walls become like liquid. Hexen II players can pass through them and drown in 
the box. If you want one of the walls to act as a solid and not as a liquid, you must put a solid 
geometry against that surface to make it seem solid.

n If you use animated textures, all of the subtextures must be included in the level. So, if you use an 
animated texture or a button, all of its subtextures must be included for the animation to work.

Add Textures to Objects 
Walk Mode Buttons 



Common Level Design Mistakes

Learning the common traps designers fall into is also helpful in the learning process. Levels created by 
inexperienced designers can often be identified by the level editing mistakes they contain.

The following list describes some of the most common level editing pitfalls and some solutions:

n Creating rooms that are too large or stringing rooms together in a line. The farther the player can 
see, the slower the computer runs, thus reducing playing speed. So, break up a large room with 
walls and other types of structures.

n Designing a level that is too difficult. The person playing your level doesn’t have the benefit of 
knowing the goal. Remember this and provide subtle clues to guide the player along a path. Add 
visual clues, such as keys, lights, interesting textures, and objects along the way.

n Making ceilings too low for the players to navigate and making hallways too narrow. The minimum 
gap that a player can maneuver is 35 Hexen II units.

n Having too much dead space. Large rooms without features look amateurish. Use odd angles or 
lighting features to enhance your playing area.



Hexen II Units
Hexen II Units Action

225 The maximum distance that a player can jump and not fall into lava, 
water, or other traps.

42.5 The maximum distance that a player can jump straight up and get to 
another object.

275 The maximum distance that a player can fall and not be injured.
35 The minimum gap in floor spacing, slatted bridge, or floating squares 

of lava.
17 The maximum height that a step can be before the player must jump.



Using Water Effectively

1 Use the Create Rectangular Object Tool to create an object.
2 Use the Create Rectangular Object Tool to create a second object that is one-half the height of the 

first object and fits entirely within the first object.
3 Select the Textures Tab, select the Texture Options Arrow, select Add Textures from the drop-down 

menu.
4 The Textures List appears.
5 Select the water texture you need and click OK.

Apply the water texture to the second object.
You have a room half filled with water.

Tips:
n Water can be an interesting and challenging feature of levels. Always plan out how far players can 

swim underwater before they die. Test this by playing. You don’t want to construct an underwater 
area that is too difficult to maneuver through.

n Avoid constructing a level that contains various water levels. Keep the water level consistent 
throughout your level.

n Remember that water is a box or container. For every room or box in which you are placing water, 
the water cannot go outside of the box. It must stay within the container. If it spills out, the water 
doesn’t exist.

n You can make the appearance of a submerged item in water. Just remember that the part that is 
underwater must be an enclosed object and the part protruding from the water is a separate 
enclosed object.



Slabbing and Hulling

If you choose not to use templates from the galleries, you can use two types of techniques as you build 
levels. Probably the most common technique is slabbing. Each wall has a front and back and top. You 
place these slabs together to form your level. You also can use a technique called hulling. With the 
hulling technique, you form an object the size and shape you want. Then you use the Connect 
Surfaces Tool to pull this object to another object. An opening is crafted where the two objects meet. 
Using hulling increases the speed at which you can build levels and also provides an easy way to 
create cool architectural features.

To hull an object, follow these steps:
1 Select the Surface Editor Tool.
2 In Top View, select the side of the object that you want to hull another object to. The Surface Editor 

Window appears.
3 Double-click on Make Transparent Button on the bottom right of the Tools Pad. The wall turns black, 

which means that it’s transparent and has no texture applied to it.
4 Click on the Return Button.
5 Select the Connect Surfaces Tool.
6 Click on the wall again.

The wall that you are hulling will shift slightly.

Tip:
Make sure that when you are hulling an object that you snap the object back to the original grid. If 
you are planning a hole in a window, be sure to put boxes around the frame to avoid unattractively 
thin walls.



Finding Leaks in Levels

METHOD ONE
1 Once you have a leak file, copy it to the maps directory with the .bsp.

(The leak file has the .pts extension.)
2 Load the .map file into Hexen II.
3 From the console enter NOCLIP so you can go outside the model and look around.
4 From the console enter POINTFILE and the leak file will be used to create lines that show you where 

the leaks are.
5 Fly around the model looking for the lines to show you where things are going wrong.

METHOD TWO
1 Save your model under a different name.
2 Use the Create Rectangular Object Tool to make an object to enclose your entire model (this object 

is called a bounding box).
3 Recompile.
If this method doesn’t work, move to method three.

METHOD THREE
1 Check over the changes made since the last time you compiled without leaks, first in Hexen II, then 

in Hexmaker.
2 If there’s a leak, you can see outside of the model “into the void.”
3 If this is the leak, fix it by putting something in the way.
If this method doesn’t work, move to method four.

METHOD FOUR
One of the things that isn’t obvious about the QBSP compiler is that it determines which parts of the 
map are “inside” by looking at all of the items in the level. If there’s an item in an area of the map, it 
assumes that area must be “inside.” So, if one of your items is outside the level, what have you is a 
sealed map with leaks. This includes lights, triggers, monsters, weapons, mana, cameras, nulls, pretty 
much anything that is not geometry. To resolve this issue, delete all the non-geometric items from the 
level.

Tip:
When you build a model, put all of your lights in one layer, monsters in another, and other items in a 
third, all separate from the layers you use for geometry.
If there’s no more leak, you have to figure out which item you recently added that “unseals” the level.

If this method doesn’t work, move to method five.

METHOD FIVE
1 Make a backup copy of you .dmm file.
2 Delete one-half of you level and seal off the other half in the obvious places.
3 Compile.

If there’s a leak, then you know at least one of the leaks is in this half of the map.
4 Repeat methods three through five on the half-map you have left.
Containment 
Convex Objects 
Rules of Drawing 



Avoiding Leaks

METHOD ONE
Build with snap-to-grid on. Rooms will generally fit together much better when you’re snapping.

METHOD TWO
Build in pieces. This isn’t always easy, but it helps in the long run: Build each separate room or small 
group of rooms by itself and then save it, compile it, light it, vis it, etc., on its own. This method helps 
prevent leaks in two ways:

1 It cuts down on compile times. All the compilations (QBSP, light, and vis) take exponentially more 
time as your map grows larger. This means that if you double the size of your map, you might 
quadruple the time it takes to compile. So, divide my map “concept” into smaller pieces and compile 
separately at first to make sure they look and feel right.

2 It allows you to check individual rooms or sections for leaks before you add them into your final level. 
This is really helpful. Smaller “levels” are easier to leak-check than larger ones.

This method does have a couple of drawbacks, though. Most notably, you have to copy-and-paste 
your room into the final level. Here are some things to consider when using this technique:

n To avoid overlapping any other portions of your “final” level, set the bottom of the Z ruler guide (the 
gray area with black arrows on the ends in the ruler) very high or very low. When you paste, 
Hexmaker will paste the room at the bottom of the Z ruler. If it’s set way low or way high, your new 
room won’t overlap your existing map.

n Cutting and pasting does not keep the connections between your rooms, so you’ll have to reconnect 
sections of your new room if they were connected before.

Containment 
Convex Objects 
Rules of Drawing 



Creating Vertical Holes Between Two Rooms

1 Select the Front View so you can see the floor or ceiling where you are placing the hole.
2 Select the Surface Editor Tool from the Design Window Tools Pad.
3 Place the cursor on the line where the top and bottom rooms join.
4 Click.

The Surface Editor appears.
5 In the Walk Window with the Surface Tool selected just click on the floor or on the ceiling of the 

object you want to edit.
6 Drag-and-drop a 2D object from the 2-D Shapes Gallery or use the Create Rectangular Objects Tool 

to freehand draw a shape.



Creating Lava-Filled Rooms

1 Use the Create Rectangular Object Tool to create an object.
2 Use the Create Rectangular Object Tool to create a second object that is one-half the height of the 

first object and fits entirely within the first object.
3 Select the Textures Tab, select the Textures Options Arrow, select Add Textures from the drop-down 

menu. 
The Textures List appears.

4 Select the lava texture you need and click OK.
5 Apply the lava texture to the second object.

You have a room half filled with lava.





Containment

Containment provides two important benefits:
1 Every object in Hexmaker knows which objects it contains and which objects contain it.

For example, if you move an object like a rectangle, all objects contained within it move and retain 
their orientation to each other. If you delete an object, all objects contained within it are deleted.

2 In Hexmaker, containment is an all-or-nothing state; an object is either fully contained within another 
object, or it is distinct from other objects.
Objects cannot overlap (but, they can be joined at a common surface).
If you drag a small object into a larger object, a state of containment exists when the mouse 
pointer reaches the interior of the larger object. The program indicates containment by displaying 

small blocks (“containment markers”)  at the vertices of the containing object. These 
markers disappear when you release the mouse button. The illustration above shows containment 
markers displayed while a small object is being dragged into a larger object.

Tip:
n Overlapping objects will not export correctly to Hexen II. Do not overlap 3-D objects!
n While it is possible to draw overlapping objects, Hexmaker does not warn you if you do this.
n Overlapping objects may not be drawn correctly, causing some background objects to appear in front 

of objects in the foreground within the Walk Window.
n To move an object without its contained objects, hold down the Ctrl key, select the room, and drag it.
Avoiding Leaks 
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Convex Objects

All objects created in Hexmaker must be convex. Convex is defined as “having a surface or boundary 
that curves or bulges outward, as the exterior of a sphere.” Virtus defines a convex object as an object 
whose polygonal outline can have a line drawn from any point on it to any other point on it without the 
line passing outside the outline boundary.
Although non-convex objects are not permitted, the appearance of a non-convex object can be 
achieved by creating more than one convex object, connecting these, and then creating an opening in 
the common wall between them.

Convex Objects

Non-convex Object
Avoiding Leaks 
Finding Leaks in Levels 



Rules of Drawing

1 Do not overlap three-dimensional objects so that one object is partially contained within another.
2 Non-convex objects are not allowed. Objects that are non-convex should be created by connecting 

two or more convex objects.
3 Speed and detail are inversely proportional: You have to give up one for the other.
4 The more complex your level, the slower you can walk through your level in the Walk Window. 

Having a larger processor will increase the apparent speed of your level.
5 Transparent objects and surfaces drain processing power: Use them sparingly.
6 Everything is an object with depth in Hexmaker. You cannot draw a line. Even if an object appears 

infinitely thin, it has depth.
Avoiding Leaks 
Finding Leaks in Levels 



Coordinates

Coordinates pinpoint the location of objects on your screen.
In the Top View of Hexmaker, X represents the horizontal units of measure on the screen (from left to 
right). Y represents the vertical units (from bottom to top). When you switch to the Front View, X still 
represents the horizontal units of measure and Z represents the vertical units. Finally, when you switch 
to the Right View, Y represents the horizontal units of measure and Z represents the vertical units.
For example, coordinates -50, 200 in the Top View translates to -50 Hexen II units on the X axis and 
200 Hexen II units on the Y axis. In the Front View, you’ll see that -50, 200 again translates to -50 
Hexen II units on the X axis, with 200 Hexen II units represented on the Z axis. And in the Right View, 
-50, 200 translates to -50 Hexen II units on the Y axis, with 200 Hexen II units represented on the Z 
axis.

In Hexen II, the orientation of Hexmaker’s design top view corresponds to the following: up is 90 
degrees, left is 180, down is 270, and right is 0.

In most cases when given only one angle choice for orientation of an object, the angle is referring to 
the angle as seen in the Top View. If an up and down angle is possible, Hexen II uses -1 as up and -2 
as down. 



Connecting

The Connect Surfaces Tool is used to join two rooms together at a common surface. There are two 
methods for connecting rooms. Rooms will only have a hole between them if one of the surfaces you 
are connecting is transparent or if it has a transparent surface on it.

1. The first method for connecting is used for connecting rooms that are not touching each other 
already. Select Connect Surfaces Tool from the Tools Pad (this tool looks like a hammer hitting a nail 
and is used to create openings between rooms). Select one of the rooms to be joined. Drag the room 
to the room that you wish to connect it to. Line up the walls to be connected so that they are parallel 
with each other and let go. The rooms should now be connected and any transparent surfaces will 
show through. 

2. The second method is used to connect to surfaces that are already touching. Select Connect 
Surfaces Tool from the Tools Pad. Click this tool on the common line between the two rooms that you 
want to connect. Hexmaker understands this to mean that you wish to connect these walls and will cut 
the transparencies out of the proper walls. 

Note: Grouped objects can not be connected to and you cannot use the connect tool within a grouped 
object. You must ungroup the objects before trying to make connections.

Tip: The connect-tool method can be used to align surfaces that are not parallel. It has the ability to 
rotate the surface of the dragged object to meet exactly the surface of the other object. This is very 
handy if you have made an object in one orientation and want to duplicate to connect to a surface that 
is facing another direction.





Windows

When Hexmaker opens, you’ll see three windows. At the left, the Gallery Window displays the galleries 
used in building levels. At the top-right, the Design Window displays the Top View, one of that window’s 
three views in which you can edit some three-dimensional objects. (The other two Design Window’s 
views are Front and Right.) Below the Design Window is the Walk Window, an empty window with a 
dark gray background. As you add objects to your level in the Design Window, the Walk Window will 
show you a three-dimensional drawing of them.

Select a 3D Gallery 
Activate a Window 



Design Window

The Design Window offers two methods to see your three-dimensional objects:

METHOD ONE
Choosing a Top, Front, or Right view allows you to edit three-dimensional objects (mana, weapons, 
and so forth).

METHOD TWO
Activating the Surface Editor Tool allows you to edit 2-D surfaces (windows, doors, and so forth). The 
window’s title bar includes the word Surface; and a 2-D gallery appears in the Gallery Window. To edit 
a 2-D surface, you select the desired surface in the Basic 2-D Gallery and drag the surface into the 
Design Window onto a selected surface. You can now edit the surface.
Activate a Window 



Walk Window

The Walk Window display a three-dimensional drawing of the two-dimensional items that you place in 
the Design Window. In this window, you can navigate through (walk through) your model.
Activate a Window 



Gallery Window

Displays a collection of either two- or three-dimensional objects or textures, depending on whether 
you’ve chosen to work with a 2-D gallery or a 3-D gallery. An object in a gallery can be dragged and 
dropped into the Design Window and edited.

The Gallery Window is always active, and you can activate either the Design Window or the Walk 
Window.
Select a 3D Gallery 
Select a 3D Gallery Object 
Activate a Window 



Navigation Buttons

Movement in the Walk Window is accomplished by using the standard Virtus navigation cursor 
techniques or the Navigation buttons along the button of the Walk Window.
Navigate 



Novice Navigation Buttons

The Navigation buttons are active when the Walk Window is active. Click on one of the Navigation 
buttons to move in that direction. If you hold down the mouse button while pointing to a navigation 
button, you move continuously.

From left to right along the bottom of the Walk Window, the Navigation buttons are:

Move 
Forward

Move 
Backward

Turn Left Turn Right Move Up Move 
Down

Navigate 



Walk Mode Buttons

The Walk Mode buttons are displayed to the left and to the right of the Novice Navigation buttons along 
the bottom of the Walk Window. The Walk Mode buttons determine what happens when you click with 
the mouse cursor in the Walk Window.

The Walk Mode buttons from left to right are:

Walk 3-D 
Surface 
Selector

3-D Select 
Object

Auto 
Texture

Level 
Observer

Home

Tip:
Only one Walk Mode button can be selected at any time.

Button Function
Walk The Walk Button allows you to “walk through’ the Walk 

Window by positioning the cursor around the cross hair.

3-D Surface Selector The 3-D Surface Selector Button allows you to quickly choose 
a surface in the Walk Window to edit; you can change in the 
surface’s texture or add surface features such as door or 
window openings.

3-D Select Object The 3-D Select Object Button allows you to select an object in 
the Walk Window and have it highlighted and centered so that 
you can edit it in the Design Window. This is extremely useful 
when you are working on a complex design and cannot select 
the correct object in the Design Window because another 
object is blocking it. (Another way around this is to change 
views, select the object, and return to the Top View to move or 
edit the object.)

Auto Texture With the Auto Texture Button, you can apply a selected texture 
to any surface you click on.

Level Observer With the Level Observer Button, you orient the Observer’s 
level of sight in the Walk Window, making it level if it has been 
altered by the Shift key while you were navigating.



Home Home Button allows you to return your position in the virtual 
environment to the 0,0,42.5 Hexen II units coordinate (at 
about eye level).

Tip:
If you use either the Select Surface Button, Select Object Button, or the Auto Texture Button, you 
need to select the Walk Button to enable navigation (walking) again.

Select a 3D Object Surface 
Add Textures to Objects 
Navigate 



Depth Control Gauges

A Depth Control Gauge appears on each ruler in the Design Window. Depth Control gauges determine 
the inflation distance and position of objects. Because there are three dimensions in Hexmaker, there 
are three Depth Control gauges that determine inflation distance and position in the X, Y, and Z 
dimensions. By reading the letter in the Dock on each ruler, you can determine which dimension each 
Depth Control Gauge is associated with.

A Depth Control Gauge consists of two black half-arrowheads on each end of a gray bar. The half-
arrowheads are called endpoints. The distance between the endpoints is the inflation distance, or the 
depth. The object position is determined by where the endpoints are in space. The endpoints 
determine where the object begin or ends.

Endpoints can be dragged to a new location, thus stretching or compressing the gray bar, or the entire 
Depth Control Gauge can be moved by dragging the gray bar.



Handles
In Hexmaker, one of four types of handles appears when you click on an object. The specific type of 
handle gives you information about how the selected object can be edited or manipulated. The handle 
types are:

Handles Functions
Black Black handles can be manipulated in any direction to change the 

object’s shape. When you’re in the Top View, all objects from the 
Basic shapes 3-D Gallery show black handles when the objects are 
selected (In the Front and Right views, white handles are shown.).

Gray Grouped objects (two or more objects selected and joined with the 
Group command in the Design menu) show gray handles when 
selected. Grouped objects first must be ungrouped (with the Ungroup 
command in the Design menu) before these objects can be 
manipulated. Gray handles also show up on objects that have been 
rotated, making them uneditable.

White A selected object showing white handles tells you that only the depth 
of the object can be manipulated. 

Red Rigid objects have red handles indicated that they cannot be resized 
or rotated, and the Object Property class cannot be changed.



Memory Indicator

The memory indicator is to the right of the message bar, at the lower-right corner of the Hexmaker 
Window. It is a square that indicates the state of your Windows memory. The memory is computed by 
adding the amount of free RAM you have to the amount of swap space, which is best estimated by the 
amount of free disk space on the drive where windows is installed. If the memory indicator is green, 
you should have enough memory to take advantage of all of the Hexmaker features. If it is yellow, you 
are low on memory. If it is red, you are almost out of memory and using Hexmaker or any other 
program further could be unpredictable.



Observer

In the Design Window, the Observer is a circle with a line extending from its center; it represents where 
you’re standing in the virtual world. The tip of the line (outside the circle) points in the direction in which 
you’re looking. When you start Hexmaker, the Observer is positioned at coordinate 0, 0. When you 
save a file, the Observer will be saved in its current position.



Surface Editor

The Surface Editor appears in the Design Window when a surface is selected. It allows you to edit the 
selected surface.



Surface Editor Tools Pad

The Surface Editor Tools Pad displays the tools you use to edit surfaces of objects. The Surface Editor 
Tools Pad has many of the same tools as the Design Window Tools Pad and a few others.
The tools exclusive to the Surface Editor are the Return Button, and the Opacity Modifier Tools.

Tools Function
Return Button The Return Button closes the Surface Editor and returns you 

to the Design Window.

Select Object Tool The Select Object Tool selects entire objects to be edited. 
Click on an object to select it. A selected object displays 
handles at its vertices. A vertex is where to object surfaces, or 
faces, meet. 

Zoom-Out Tool The Zoom-Out Tool decreases the apparent scale of the 
Design Window. Select the Zoom-Out Tool by clicking on it, 
point to the area that you want to zoom away from, and click 
to decrease the apparent scale of the Design Window by a 
factor of two.

Zoom-In Tool The Zoom-In Tool increases the apparent scale of the Design 
Window. Select the Zoom-In Tool by clicking on it, point to the 
area that you want to zoom toward, and click to double the 
apparent scale of the Design Window.

Resize Object Tool The Resize Object Tool scales an object about its center or 
about a specified anchor point. Objects are resized uniformly 
along all three axes or non-uniformly along a single axis.

Create Rectangular Object 
Tool

The Create Rectangular Object Tool draws a rectangle.

Rotate Object Tool The Rotate Object Tool is used to rotate an object. This tool 
works in any view (Top, Front, and Right), allowing rotation 
around more than one axis.

Lock Object Tool The Lock Object Tool functions in the Design Window and in 
the Surface Editor. It allows you to lock objects or surface 
features so they cannot be edited. A locked object is visible in 
the Design Window but cannot be selected or changed until it 
is unlocked. To do so, select Unlock All from the Edit menu.

Add/Remove Handle Tool The Add/Remove Handle Tool lets you add a new handle to a 
surface feature or remove an existing handle. A handle 
represents the vertex (the meeting of two object surfaces).

Create Irregular Object 
Tool

The Create Irregular Object Tool draws an irregular-shaped 
object, one segment at a time. This tool does not draw non-
convex objects or surface features.

Opacity Modifier Tools The Opacity Modifier Tools can be used to change the opacity 
of an objects surface to opaque or transparent. The Make 



Opaque Button is on the left; the Make Transparent Button is 
on the right.

Tip:
When the Surface Editor is open, the Gallery Window changes to show the Basic 2-D Gallery, a 
collection of surface features. A surface feature, like an object, can be dragged from the gallery and 
dropped into the Surface Editor onto a selected surface.

Lock an Object 
Unlock an Object 
Resize an Object 
Resize an Object About Its Center 
Resize an Object About an Anchor Point 
Rotate 
Cut a Hole 
Select an Object Surface 



Design Window Tools Pad

When you open Hexmaker, the Design Window Tools Pad displays the tool you use to edit objects. 
Below is a description of its tools and how they function.

Tool Function
Zoom-In Tool The Zoom-In Tool increases the apparent scale of the Design 

Window. Select the Zoom-In Tool by clicking on it, point to the 
area that you want to zoom toward, and click to double the 
apparent scale of the Design Window. Use the Ctrl key and 
this tool to Zoom-Out.

Connect Surfaces Tool The Connect Surfaces Tool functions in the Design Window 
and is used to connect two objects together at a command 
surface. A connection between surfaces is necessary to see 
any common surface features such as the transparent surface 
features representing doorways or windows. Without the 
connection, surface features between objects are not shared 
and holes do not penetrate both surfaces.

Select Object Tool The Select Object Tool selects `objects to be edited. Click on 
an object to select it. A selected object displays handles at its 
vertices. A vertex is where to object surfaces, or faces, meet. 

Lock Object Tool The Lock Object Tool functions in the Design Window and in 
the Surface Editor. It allows you to lock objects or surface 
features so they cannot be edited. A locked object is visible in 
the Design Window but cannot be selected or changed until it 
is unlocked. To do so, select Unlock All from the Edit menu.

Hide Object Tool The Hide Object Tool functions in the Design Window and in 
the Surface Editor and allows you to hide objects or surface 
features in the Design Window, the Walk Window, or both. 
Hidden objects and surface features are not visible in the 
Design Window but are still a part of your level. They can be 
seen in the Walk Window. To make them visible again in the 
Design Window, choose Show All from the Edit menu.

Resize Object Tool The Resize Object Tool scales an object about its center or 
about a specified anchor point. Objects are resized uniformly 
along all three axes or non uniformly along a single axis.



Skew Object Tool The Skew Object Tool distorts an object from its true 
symmetrical form, taking the object out of plumb. An object 
can be skewed on more than one axis but only from the view 
in which it was created.

Create Rectangular Object 
Tool

The Create Rectangular Object Tool draws a rectangle.

Create Irregular Object 
Tool

The Create Irregular Object Tool draws an irregular-shaped 
object, one segment at a time. This tool does not draw non-
convex objects or surface features.

Add/Remove Handle Tool The Add/Remove Handle Tool lets you add a new handle to a 
surface feature or remove an existing handle. A handle 
represents the vertex (the meeting of two object surfaces).

Rotate Object Tool The Rotate Object Tool is used to rotate an object. This tool 
works in any view (Top, Front, and Right), allowing rotation 
around more than one axis.

Surface Editor Tool When you press the 3-D Surface Selector Button and select a 
surface to edit in Hexmaker’s Design Window, the Surface 
Editor appears and the Surface Editor Tools Pad replaces the 
Design Window Tools Pad. The selected button determines 
where the texture or surface feature is applied to the surface.

Tumble Editor Tool The Tumble Editor Tool allows you to edit the selected object 
and slice parts of it off to create irregular object shapes..

Lock an Object 
Unlock an Object 
Resize an Object 
Resize an Object About Its Center 
Resize an Object About an Anchor Point 
Rotate an Object 
Cut a Hole 
Select an Object Surface 
Move an Object 
Select an Object 
Add a Handle to an Object 
Skew an Object 



Connect Two Surfaces 
Modify Opacity 



Menus

Menus allow you to display Hexmaker commands. Some are typical Windows 95 menus you are 
familiar with and others are unique to Hexmaker. This section lists them and describes them for you. 



File Menu

Command Purpose
New creates and opens a new Hexmaker file.

Open. . . displays the Open dialog from which you can select a file to open. 
Close closes the current file. If you made any changes to the file since the 

last time you saved it, you are prompted to save the changes before 
the file is closed.

Save saves the current file under the currently used name or prompts you 
for a name if untitled.

Save As. . . opens the Save As. . . dialog, which allows you to save the current 
file under a new name.

Game Options allows you to set level options, game settings, and Hexmaker 
defaults.

Hexen Export allows export of .map files and creation of .bsp file with lighting and 
visibility so your level can be played in Hexen II.

Exit exits Hexmaker. If a file is open and changes were made since the 
last time it was saved, you are prompted to save any changes before 
exiting.



Edit Menu

Command Purpose
Undo undoes the last operation performed in the Design Window. 

Cut moves any selected objects to the Clipboard. Cut objects can be 
pasted with the Paste command.

Copy copies any selected objects to the Clipboard, leaving the original in 
place. (Note that Cut moves objects to the Clipboard and does not 
leave the original in place.)    Copied objects can be pasted with the 
Paste command.

Duplicate makes an exact copy of any selected object or surface feature and 
places it on or near the original. Unlike the Cut and the Copy 
commands, Duplicate does not copy to the Clipboard.
Duplicate duplicates objects as well as object placement, scaling, 
and rotation. For example, you can create an object, duplicate that 
object, and position the second object on the right side of the original 
so that the objects appear to be touching. Then you can select 
Duplicate again and an identical third object, joined on the right side 
of the second object, will appear; you’ll have a line of three objects 
spaced the same distance apart. The duplicate’s position relative to 
the object that it duplicated is maintained as long as the original 
object remains selected. If you continue choosing Duplicate, the 
objects will continue duplicating to the right until you have a line of 
identical objects. This can be extremely helpful in creating objects 
such as staircases or fence posts.
Changes to Object Type are not duplicated. For example, if you 
create an object 100 Hexen II units tall and then duplicate it and 
increase the height of the duplication to 150 Hexen II units, 
subsequent duplications will have a height of 150 Hexen II units—
they will not grow in height by increments of 50 Hexen II units.

The Duplicate command only duplicates manipulations to the entire 
object. It does not duplicate changes to part of an object. 

Paste copies the contents of the Clipboard into the level.
Delete removes selected objects or    surface features without placing them 

in the Clipboard. Selected objects can also be deleted by pressing 
the Delete key or the Backspace key. Delete removes objects 
completely, whereas Cut moves objects to the Clipboard from which 
they can be pasted back into the level.
If you Delete or Cut something accidentally and need to reverse that 
action, immediately choose Undo under the Edit menu after the 
cutting or clearing operation.

Select All selects all objects.
Unselect All unselects objects or surface features (handles are removed). Another 

method of unselecting is clicking on the background in the Design 
Window or Surface Editor. 

Hide Selected hides selected objects and surface features. Hiding objects or 
surface features allows you to work on surface features without 
having to shuffle them.
By default, hidden objects are hidden in the Design Window and 
surface features are hidden in the Surface Editor, but they remain 
visible in the Walk Window.

Unhide All displays surface features hidden in the Design Window. The Ctrl key 
must be held down in conjunction with Show All to display them. If 



using the Ctrl key with this command, you must select the command 
from the menu; you cannot use the command key equivalent.

Increase Grid Size increases the number of grid lines per unit by half in the design 
window.

Decrease Grid Size decreases the number of grid lines per unit by half in the design 
window.

Lock Selected locks selected objects in the Design Window and selected surface 
features in the Surface Editor. Locking objects or surface features 
prevents them from being edited. When an object or surface feature 
is locked, its polygonal outline is solid.

Unlock All unlocks all locked objects and surface features locked with the Lock 
Object Tool or with the Lock Selected command to allow editing. You 
can also lock a layer, which locks all objects on that layer.

Preferences The Preferences dialog allows you to set preferences for Hexmaker.
Each time you save a Hexmaker level, any changes that you made to 
the Preference settings are saved with it. When you open the model 
again, its preferences are restored.
Preferences includes three separate tab selections: Editor, 
Rendering, and Navigation. 

Tip:
If you want to accomplish the effect of an incremental increase in size or shape, you must use the 
Resize Object Tool to adjust the size or shape of the first duplication and then duplicate it.



Preferences, Editor Options 

Command Purpose
            Aids

Show Ruler if selected, displays rulers.
Show Grid if selected, displays the background grid based on the 

ruler’s major tick marks.
Show Depth if selected, displays the Depth Control gauges on the 

rulers.
Show Guides if selected, displays Non-Reproducing Guidelines.
Show Origin if selected, displays Movable Origin.
Snap to Grid if selected, snaps objects and surface features to an 

invisible grid when they are created, moved, or edited.
The grid is based on the ruler tick marks in the Design 
Window and Surface Editor. Handles of objects and 
surface features will “snap to” the grid when Snap to 
Grid is selected.
If you zoom in or out, the ruler tick marks change, 
changing the invisible grids. For example, each tick mark 
represents one Hexen II unit, so Snap to Grid will snap 
objects to the nearest Hexen II unit.
If Snap to Grid is not selected, the ability to create, edit, 
and move objects and surface features is constrained 
only by screen pixels.
If an object, surface feature, or slice is created with Snap 
to Grid unselected and then edited or moved with Snap 
to Grid selected, the object or surface feature moves in 
increments of the invisible grid but doesn’t actually snap 
to the grid. This makes it possible for handles to fall 
between the ruler tick marks, which can be frustrating 
when you try to align objects or surface features. 
However, if you move a handle rather than the whole 
object or surface feature, the handle will snap to the grid.

Object Class if selected, displays object class in Design Window info 
bar when the cursor passes over it.

            Color
Ruler lets you specify ruler color.
Grid lets you specify Grid color.

Depth lets you specify Depth Control Gauge color.
Guide lets you specify Non-Reproducing Guideline color.
Origin lets you specify Movable Origin color.

Background lets you specify background color. The background color 
is the color of the drawing area in the Design Window 
and Surface Editor.



Preferences, Rendering Options

Command Purpose
            Shading

Shaded displays objects with lighting effects.
Unshaded displays object colors with no lighting effects.

White displays objects with no color (white color fill) and no lighting effects.
            Drawing

Fill & Frame displays both the color fill and wire frame of objects.
Fill displays only the color fill of objects with no wire frame.

Frame displays only the wire frame of objects.
            Flash 
Graphics

turns on Virtus Corporation drawing routines and uses those routines 
instead of the standard Microsoft Windows drawing routines. Flash 
Graphics substantially speeds up the Hexmaker application. Flash 
Graphics is turned on by default; however, some video boards are 
not compatible with Flash Graphics. The Hexmaker application 
checks for compatibility with your system when you install, and if a 
conflict is detected, Flash Graphics is turned off.

            Options
Dithering is a technique that allows more colors, thus more color-accurate 

renderings. Dithering is turned on by default. The disadvantage of 
dithering is that the screen appears more grainy.

Tip: 
If you turn off the check box and are not experiencing difficulties with the graphics, you will get errors 
when using textures and when viewing three-dimensional geometry’s in the Walk Window.



Preferences, Navigation Options

Command Purpose
            Aids
Cross Hair if selected, displays a cross hair in the Walk Window that is used as a 

reference point for direction and walk through speed.
Velocity 

Grid
if selected, displays horizontal and vertical marks at increments relative 
to the cross hair where walk speed changes.

Collision 
Detect

if selected, the Observer can move through doors or transparent 
openings on surfaces only. When the Observer encounters a wall, it 
stops; a clicking sound confirms that the Observer ran into a wall.



Design Menu

Command Purpose
Snap to Grid snaps objects and surface features to an invisible grid when they are 

created, moved, or edited. The grid is based on the ruler tick marks in 
the Design Window and Surface Editor. Handles of objects and surface 
features “snap to” the grid when Snap to Grid is selected.
If you zoom in or out, the ruler tick marks change, changing the invisible 
grids. For example, each tick mark represents one Hexen II unit, so 
Snap to Grid will snap objects to the nearest Hexen II unit.
If Snap to Grid is not selected, the ability to create, edit, and move 
objects and surface features is constrained only by screen pixels.
If an object or surface feature is created with Snap to Grid unselected 
and then edited or moved with Snap to Grid selected, the object or 
surface feature moves in increments of the invisible grid but doesn’t 
actually snap to the grid. This makes it possible for handles to fall 
between the ruler tick marks, which can be frustrating when you try to 
align objects or surface features. However, if you move a handle rather 
than the whole object or surface feature, the handle will snap to the grid.
Snap to Grid can be selected and unselected under Preferences Editor 
dialog and the Design menu.

Zoom-In increases the apparent scale and size of objects in the view by a factor 
of two. With each zoom in, the minor tick marks on the rulers represent 
a smaller unit of measurement. There is a limit to the range of the Zoom-
In command; when you reach the limit, selecting Zoom-In will have no 
effect.
Zooming in can also be accomplished by clicking on the Zoom-In tool. 
Zoom-Out reverses the effect of Zoom-In.

Zoom-Out reduces the apparent scale and size of objects in the view by half. With 
each zoom-out, the minor tick marks on the rulers represent a larger unit 
of measurement. There is a limit to the range of the Zoom-Out 
command; when you reach the limit, selecting Zoom-Out will have no 
effect.
Zooming out can also be accomplished by clicking the Zoom-Out Tool. 
Zoom-In reverses the effect of Zoom-Out

New Layer lets you add a new layer to the Layer List. If you select New Layer, a 
dialog appears with a text box in which you can type the new layer 
name. This name will then appear in the Layers Window and become 
the active layer.

Delete Layer deletes the selected layer in the Layer List and all the objects that reside 
in that layer. If you select Delete Layer, you are prompted to verify the 
deletion

Group groups all selected objects, treating them as a single object. A grouped 
object can be moved, copied, rotated. It can only be scaled using the 
Scale Object tool. It is important to group gallery items with the Group 
command before copying them to a gallery. 

Ungroup ungroups selected objects that were grouped with the Group command. 
Once you ungroup an object, all the objects that make up the group 
remain selected until you click somewhere else inside the view. This 
means that if you want to change the texture of a grouped object, you 
can ungroup it, select a new texture, and group the objects again. This 
only works if you want all objects within the group to be the same 
texture. It’s a good idea to group staircases before moving them.



It is possible to have groups within other groups. If you ungroup an 
object but cannot edit it, try ungrouping again.

Tip: 
The Design menu is available only when a Design Window is active. If the Surface Editor or Walk 
Window is active, the Design menu disappears.



Window Menu

Command Purpose
Design displays or hides the Design Window.

Walk displays or hides the Walk Window.
Tools displays or hides the Tools Pad.

Layers displays or hides the Layers Window.
Tile Horizontal positions the active window on top. The Gallery Window is positioned 

normally, that is, to the left of the other windows.
Tile Vertical positions the active window on the left. The Gallery Window is 

positioned normally, that is, to the left of the other windows.

Hexen II Object Properties Dialog

The Hexen II Object Properties dialog allows you choose settings that affect how objects in your newly 
created level will look when exported to Hexen II. The settings do not affect the appearance of your 
level, objects, or textures in the Design Window or the Walk Window.

To view the Hexen II Object Properties dialog as you read this section, drag and drop a Square from 
the Basic Shapes Gallery into the Design Window. Right-click the square to bring up the dialog.

Add Objects to a Gallery 
Select a 3D Gallery Object 
Use a Basic 3D Gallery Object 
Create Your Own Custom Objects 
View the Hexen II Object Properties Dialog 
Objects 



Object Properties Object Tab

Dialog box element Description/purpose
Class This is a list of all of the objects that are available for you to use to 

build levels. Choose from this list to create a place holder that will act 
like one of the possible elements in Hexen II

Attributes These are the user definable fields for each class item. See the Hexen 
Code Comments.txt file installed with this program for more details on 
each attribute and on how to set attributes and combine classes.

Flags These are flags that can be set to effect the way this class item works.
Levels These check boxes determine which level the classes appear on in 

Hexen II. If you check only Deathmatch for a Pot, it will not show up in 
single player mode.

Select a 3D Gallery Object 
Use a Basic 3D Gallery Object 
Create Your Own Custom Objects 
Objects 



Object Properties    Advanced Tab

Dialog box element Description/purpose
Geometry Options

Hollow 
Geometry: 
Expand In

Walls in Hexmaker are infinitely thin. For Hexen II, walls need to 
have thickness. Most of the time, wall thickness is set automatically 
during the Hexen II export. If you test your level (made in 
Hexmaker) in Hexen II, and the player falls through floors and goes 
through walls, you need to use the Hollow Geometry: Expand In or 
Hollow Geometry: Expand Out tool on that room. This hollowing in 
does not appear in the Design View but it will effect your level in 
Hexen II after export.

Hollow 
Geometry: 

Expand Out

Walls in Hexmaker are infinitely thin. For Hexen II, walls need to 
have thickness. Most of the time, wall thickness occurs 
automatically during the Hexen II export. If you test your level 
(made in Hexmaker) in Hexen II and the player falls through floors 
and goes through walls, you need to use the Hollow Geometry: 
Expand In or Hollow Geometry: Expand Out tool on that room. This 
hollowing in does not appear in the Design View but it will effect 
your level in Hexen II after export.

Solid 
Geometry

Nothing will be in this object while playing Hexen II, it can be solid

Custom Object has 
geometry

If you are creating a custom object and select Custom in the Class 
drop-down list under the Hexen II Object Properties Dialog tab, you 
need to decide if the object needs geometry shapes.

Contains The items in the contains area, if ungreyed, allow you to fill chests, 
and badguys pockest with lots of goodies to give to the player when 
he opens or defeats the foe.

Select a 3D Gallery Object 
Use a Basic 3D Gallery Object 
Create Your Own Custom Objects 
Add Objects to a Gallery 





Hexmaker Online Help Guide Introduction

Hexmaker™ provides everything that you need to create and edit 3-D worlds for Hexen II™.    
Hexmaker features an easy to use drag and drop interface that lets you work with pre-created content 
to build Hexen II worlds quickly.    You can also use the modeling and construction tools to create your 
own items and to build structures that extend beyond the pre-created content.

This is an online-help guide designed give you all of the information you need to design and build 
Hexen II levels.    This guide includes information on    the product interface, step by step instructions 
for some of the more common tasks, a guide to designing levels, and details about the product 
interface. 

For more information on Hexmaker, check out the Web Site at www.hexmaker.com.    If you have 
installation and setup problems, email support@mcp.com.
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